Training Schedule for Microsoft Office Basics

Computer Basics Using Microsoft Windows

This course is for those with little or no prior experience with computers. Participants will gain an understanding of the basic concepts of hardware, software and data. Participants will make basic use of computer hardware and perform computer operation and file management using Microsoft Windows, touch typing using tutorial programs, and basic word processing using Microsoft Word. 
	Day 1
	Introduction to Computers and Microsoft Windows

	Objectives
	Basic terminology: hardware, software, data, input, processing, output, etc.

Start and shut down the computer

Mouse movement; click, right click and double click; icons, buttons and menus

Start applications using desktop icons and the Start menu

Maximize, minimize and close applications using buttons in upper right corner

Arrange or switch between two or more running applications using the taskbar

Briefly use simple applications (Accessories: Notepad, WordPad, Calculator, Paint)

Start and use Help (contents, index, search, navigation)

	Activities
	Registration, introductions, course overview

Windows 98 Help and Tour

NETg tutorial 12089: Introduction to PCs and Applications

NETg tutorial 70011: Windows 95 Fundamentals

	Readings
	A & A: Chapter 1: Introduction to Computers, pp. 1-22
A & A: Chapter 2: Windows 95 Basics, pp. 23-37, 50-54
QuickSource: Windows 98, p. 1

Long & Long pp. 10, 15, 228-240 Core

Computers in Your Future 3, Module 1A: computer and information literacy

Computers in Your Future 3, Module 3A: system software


	Day 2
	Touch Typing

	Objectives
	Create a text document; practice typing

Cursor movement; deleting characters

Use keys for letters, numbers, capitals, symbols, navigation, shortcuts

Position fingers on home row keys and press keys with correct fingers

Start and exit the typing tutorials, take practice tests, complete lessons, play games

Achieve a speed of at least 10 words per minute by the end of the course

Modify equipment and behaviour for safe, comfortable ergonomic computer use

	Activities
	typing tutorials

	Readings
	A & A p. 11 (keyboard keys)

Long & Long pp. 96 Core (keyboard), 108 AT (positioning)
Computer and desk exercises (stretching)


	Day 3
	Microsoft Word: Document Creation and Text Editing 

	Objectives
	Start and exit Word

Save, close and open documents

Switch between two or more open documents using the Window menu

Select, cut, copy, paste, undo, redo using the Edit menu, buttons and Ctrl keys

Move text using Drag and Drop technique (with the mouse)

Start and use Word Help

	Activities
	A&A p. 65 (work3)

Long & Long, pp 4-6 AT: Memo

Word Help

	Readings
	A&A, pp. 55-66

QuickSource: Word 2000, pp. 1-2

Computers in Your Future 3, Module 4B: word processing


	Day 4
	Document Formatting and Viewing

	Objectives
	Format text (change size, font, font style, colour, highlight, etc.)

Format paragraphs (alignment, indent, spacing)

Create bulleted and numbered lists

Use ruler to indent text, create tab stops

Switch between views/layouts (normal, web, print, outline)

	Activities
	A&A, pp. 64, 67, 72, 73 (work3-9)
Long & Long, p. 7 AT: Computer Word Processing Features

NETg tutorial 72020: Word 2000 Fundamentals

	Readings
	A&A, p. 60
QuickSource: Word 2000, p. 2, 6


	Day 5
	Management of Documents, Folders and Windows Settings

	Objectives
	Use My Computer and Windows Explorer and Search/Find

View contents of Desktop, My Computer, Recycle Bin, Control Panels, Printers

View C:\, Windows, My Documents, Program Files, Start Menu and Favorites folders

Create, Rename, Copy, Move, Delete, Find files, folders and shortcuts

	Activities
	Workshop conclusion: save work, check objectives, certificates, evaluation

	Readings
	A&A, pp. 38-50

QuickSource: Windows 98, pp. 1-3

Computers in Your Future 3, Module 2B: data storage 


Word Processing Using Microsoft Word

Prerequisite: Computer Basics course or equivalent basic computer skills. Participants will create and edit documents using Microsoft Word. Topics include document management, navigation, viewing, editing, formatting, and printing; and tables, images and objects.
	Day 1
	Review of Microsoft Word Basics: Editing and Formatting

	Objectives
	Start and exit Word

Save, close, open and create new documents

Switch between two or more open documents using the Window menu

Select, cut, copy, paste, undo, redo using the Edit menu, buttons and Ctrl keys

Move and copy text using Drag and Drop technique (with the mouse)

Format text (change size, font, font style, colour, highlight, etc.)

Format paragraphs (alignment, indent, spacing)

Create bulleted and numbered lists

Use ruler to indent text, create tab stops

Find and replace text 

Sort text alphabetically

Start and use Word Help

	Activities
	Registration/needs survey, introductions, workshop overview 

A&A, pp. 64, 67, 72, 73, 76, 82 (work3-10, 13)
Long & Long, pp. AT 4-6: Memo (March Sales Summary.doc)

Long & Long, p. AT 7: Computer Word Processing Features (wpsoft.doc)
NETg tutorial 72020: Word 2000 Fundamentals

	Readings
	A&A, pp. 55-59, 61-63, 65-66, 69-71, 75, 81

QuickSource: Word 2000, pp. 1-6

Computers in Your Future 3, Module 4B: word processing

Word 7 Advanced Features, pp. 8, 23-24


	Day 2
	Large Document Management

	Objectives
	Switch between views/layouts (normal, web, print, outline)

Use page setup, print preview and print

Arrange, split and switch between windows

View and change document properties (author, title, word count, etc.)

View and edit headers and footers

Insert menu (page numbers, page and section breaks, special symbols, footnotes) 

Create a multilevel list

Apply styles to headers and paragraphs and change formatting of existing styles

Create a table of contents and an index from a document with styles

Create a master document and sub-documents

	Activities
	lists.doc, styles.doc

	Readings
	A&A, pp. 60, 74, 79, 80, 86
Word 7 Advanced Features, pp. 2-6, 10-11, 22, 27-30, 34 


	Day 3
	Tables, Columns, Images and Objects 

	Objectives
	Add, delete, format, resize and add borders and shading to tables, rows and columns

Convert between table and tab-delimited text

Insert, move, resize: drawings, clip art, picture files, charts, objects, word art, symbols

Use object linking and embedding and paste special

	Activities
	A&A, pp. 84, 85 (work16-19)

Long & Long, p. AT 8: Integrating Tables and Graphs (March Sales Summary.doc)

tables.doc

	Readings
	A&A, p. 83

Word 7 Advanced Features, pp. 16-21, 32-33, 40-41


	Day 4
	Special Documents

	Objectives
	Use mail merge to create multiple documents from a database and master document

Create envelopes, labels, business cards and other documents of different page sizes

Create documents using templates and wizards

Use desktop publishing features to create newsletters, brochures and pamphlets

	Activities
	Wizards and templates for letters, memos, reports, resumes, business plans, etc.

	Readings
	Word 7 Advanced Features, pp. 12-14, 31


	Day 5
	More Editing and Formatting

	Objectives
	Find and replace text, formats, styles and special characters

Check spelling and grammar; set language; use Thesaurus to find synonyms

Use AutoText to store and insert a frequently used part of a document

Create a template to store a frequently used document format and content

Create a macro to perform a frequently used task

View and change document properties (author, title, word count, etc.)

View and change options and auto-correct features

Customise menus, toolbars and keyboard shortcuts

	Activities
	A&A, pp. 88-91 (work22-26)
Workshop conclusion: save work, check objectives, certificates, evaluation

	Readings
	A&A, pp. 77, 78

Word 7 Advanced Features, pp. 7, 25, 35


Spreadsheets Using Microsoft Excel

Prerequisite: Computer Basics course or equivalent basic computer skills. Participants will create and edit spreadsheets using Microsoft Excel. Topics include data entry, navigation, viewing, formatting, sorting, summarizing, and printing; formulas and functions; and objects, images, charts and graphs.
	Day 1
	Microsoft Excel Basics: Editing and Formatting

	Objectives
	Start and exit Microsoft Excel

Enter text and numbers into a worksheet

Save, close and open an Excel file

Format numbers: currency, percent, comma, decimal

Format cells, rows and columns: size, font, style, alignment, borders, shading, merge, etc.

Change column width and row height

Select, cut, copy, paste, move, insert, delete and clear cells, rows and columns

Sort a selection in ascending or descending order using one or more selected columns

Find and replace text

	Activities
	Registration/needs survey, introductions, workshop overview

A&A, pp. 106 (as. 1), 112 (as. 2)

Grauer & Barber, p. 5: gradebook; p. 37: budget

NETg tutorial 72030: Excel 2000 Fundamentals

	Readings
	A&A, pp. 93-112

QuickSource: Excel 2000, pp. 1-6

Computers in Your Future 3, Module 4C: spreadsheets

Excel Help 


	Day 2
	Formatting, Viewing and Navigation 

	Objectives
	View multiple windows, worksheets and workbooks at the same time

Format cells (number, alignment, font, border, patterns, protection) and copy formats
View and hide toolbars

Modify headers and footers 

Use page setup, print preview and print

Move between different worksheets and workbooks

Insert, delete, rename, copy and move worksheets

	Activities
	Grauer & Barber, p. 66: forecast, p. 77: invoice

A&A, pp. 124 (as. 4)

	Readings
	A&A, pp. 113-115, 117, 119-123, 126


	Day 3
	Calculations, Formulas and Functions

	Objectives
	Use the AutoSum button to create a formula that sums a row or column

Copy formulas to a different row or column

Fill: down, right, series, fill handle

Use relative and absolute cell addresses

Use references (links) to cells in different worksheets and workbooks

Create simple and compound functions using the function wizard

Type and edit formulas by hand

Use IF, nested IF, AND, OR, NOT, VLOOKUP and HLOOKUP functions

Use the function button to calculate sum, average, and statistical functions

	Activities
	Long & Long, pp. 22-25 AT: sales commissions

A&A, pp. 118 (as. 3), 132

Microsoft Business Planner examples: balance sheet, income, cash flow, break even

	Readings
	A&A, p. 116

QuickSource: Excel 2000, p. 4


	Day 4
	Charts, Graphs and Objects

	Objectives
	Create different types of charts and graphs with the chart wizard toolbar button

Change chart size, location, type and options (title, axes, gridlines, legend, data labels)

Copy charts and tables and paste into a Word document as objects

Add, delete, resize, move and copy drawings, clip art and word art to a worksheet

	Activities
	LandDisturbance.xls

Long & Long, p. AT 26: graph

Grauer & Barber, p. 164: compound document

A&A, pp. 130 (as. 5), 131

	Readings
	A&A, p. 125

QuickSource: Excel 2000, p. 5


	Day 5
	Data Manipulation

	Objectives
	View, add, remove, edit, and search records using the data form

Filter data using autofilter

View, remove and show and hide detail in outlines

Create and remove subtotals

Name, delete and use cell ranges; select cell ranges using pointing

Create, remove and modify pivot tables

Use goal seek to work backwards in a calculation

Create and switch between scenarios

Use tracer arrows to discover the source of error values

	Activities
	pivottable.xls, subtotals.xls, autofilter.xls

Workshop conclusion: save work, check objectives, certificates, evaluation

	Readings
	Excel Advanced Features, pp. 22-34, 37-43


Databases Using Microsoft Access

Prerequisites: Proficiency in Windows, Word Processing and Spreadsheets. Participants will learn database terms and concepts; navigate and enter data into an existing database; design and create tables, queries, forms and reports using wizards and design view; and define relationships to create a relational database. Participants will create a complete database as an extended example.
	Day 1
	Database Concepts and Microsoft Access Basics 

	Objectives
	List and describe common uses and applications of databases.

Compare database management systems with paper for data storage and access.

Describe object-oriented concepts such as object, attribute, instance, and value.

Start and exit Microsoft Access.

Open and close an existing sample database (e.g. Northwind).

Copy the sample database into your folder using Windows Explorer.

View the different types of database objects (tables, queries, forms, reports, etc.).

View and print preview existing tables, queries, forms and reports.

Use tables and forms to enter and change data in fields and insert and delete records.

Use Microsoft Access Help.

	Activities
	Registration/needs survey, introductions, workshop overview

Northwind.mdb

NETg tutorial 72050: Access 2000 Fundamentals: Unit 1, Lessons 2 and 3

	Readings
	IT II handout, pp. 1-5

Computers in Your Future 3, Module 4D: Databases, pp. 51-57
Grauer & Barber 97, pp. 3-5, 14-16

Long & Long, pp. 

UoW, pp. 105-112

A&A ch. 5, pp. 133-141, 154

QuickStudy: Access 2000, pp. 1-3

Access Help: Creating and Working with Databases, Working with Data


	Day 2
	Tables and Fields

	Objectives
	Create a table using the table wizard and design view.

Modify a table using design view (add, delete, rename and modify fields).

For each field, choose an appropriate data type (text, number, date/time, memo, etc.).

Change field properties (maximum size, decimal places, input mask, default value).

Define validation rules (using expressions, values, constants, operators and functions).

Import tables from Microsoft Excel worksheets; export tables to worksheets or text.

	Activities
	Create a bookstore database bookstore.mdb and its tables.

NETg tutorial 72050: Access 2000 Fundamentals: Unit 2

	Readings
	IT II handout, p. 2

Grauer & Barber 97, pp. 41-43

UoW, pp. 112-117

A&A ch. 5, pp. 142-151

QuickStudy: Access 2000, p. 4
Access Help: Tables, Datasheets


	Day 3
	Relationships and Database Design Principles

	Objectives
	Describe the entity-relationship model of data representation.

List the advantages of relational databases over flat files and spreadsheets.

Describe five capabilities of a good database management system.

List the tasks involved in planning a relational database.

Identify primary and foreign keys in existing tables.

Use the Relationships window to create one-to-many relationships by linking keys.

	Activities
	Use the Relationships window to link the tables in bookstore.mdb.

NETg tutorial 72050: Access 2000 Fundamentals: Unit 1, Lesson 1

	Readings
	Grauer & Barber 97, pp. 26-28

Computers in Your Future 3, Module 4D: Databases, pp. 52-53, 56-57

Access Help: Primary Keys and Indexes, Relationships and Referential Integrity


	Day 4
	Searching, Sorting, Queries and Filters

	Objectives
	Search for and change information in tables using Find and Replace.

Sort tables by one or more fields in ascending or descending order using Sort buttons.

Filter by selection, exclusion, input or form to display records matching given criteria.

Use advanced filter/sort to perform complex filtering and sorting of records.

Create queries using single or multiple tables using a wizard.

Create and edit queries in design view using Fields, Sort, Show, and Criteria.

	Activities
	Search, sort, query and filter bookstore.mdb and northwind.mdb.

NETg tutorial 72050: Access 2000 Fundamentals: Unit 3

	Readings
	IT II handout, p. 3

Grauer & Barber 97, pp. 13-14, 101-105

UoW, pp. 109-110, 117-122

A&A ch. 5, pp. 152-153

Access Help: Working with Data, Queries, Expressions


	Day 5
	Forms and Reports

	Objectives
	Create forms and reports based on single or multiple tables or queries using wizards.

Create and edit forms and reports using design view.

Create columnar, tabular and summary reports.

Create charts using the Chart Wizard.

	Activities
	Create forms and reports for bookstore.mdb.

Workshop conclusion: save work, check objectives, certificates, evaluation

	Readings
	IT II handout, pp. 4-5

Computers in Your Future 3, Module 4D: Databases: review questions

Grauer & Barber 97, pp. 53-58, 88-93

UoW, pp. 122-132

QuickStudy: Access 2000, p. 4

Access Help: Forms, Reports and Report Snapshots


Presentations Using Microsoft PowerPoint

Prerequisites: Proficiency in Windows and Word Processing. Topics include presentation creation, editing and formatting; image editing and manipulation; charts and tables; multimedia effects; and data formats. Each participant will design and create an electronic presentation on a work-related topic of his or her choice and present it to the other participants on the final day of the course.
	Day 1
	Microsoft PowerPoint Basics 

	Objectives
	List and describe common purposes and uses of presentations.

Start and exit Microsoft PowerPoint.

Open, close and view a sample presentation.

Create a presentation (using a wizard, template, or an existing or blank presentation).

Select an appropriate slide layout for a given slide content.

Switch between views (slide, slide show, outline, notes, slide sorter, and master).

Add text to a presentation in slide or outline view.

Insert, delete, cut, copy, paste and duplicate slides.

Use the slide sorter view to change the order of slides.

Use Microsoft PowerPoint Help.

	Activities
	Registration/needs survey, introductions, workshop overview

NETg tutorial 72030: PowerPoint 2000 Fundamentals

Participant presentations: select topic; gather content.

	Readings
	Computers in Your Future 3, Module 4E: Presentation Packages, pp. 67-70
QuickStudy: PowerPoint 2000, pp. 1-4

Quick Source: PowerPoint 2000, pp. 1-6

Microsoft PowerPoint Help

PowerPoint 7 Complete Concepts and Techniques, pp. 

Long & Long, pp. 

Instructional Media and Technologies for Learning, pp. 


	Day 2
	Editing and Formatting

	Objectives
	Describe the general structure of a typical presentation.

Add formatting to text (font, case, bullets, numbering, alignment, indents, tab stops).

Insert, move, resize and format text boxes.

Use format painter and search and replace to change text.

Choose a template and colour scheme for all slides.

Use the slide master view to change the backgrounds of the title and other slides.

Insert a summary slide of selected slides using the toolbar.

Hide one or more slides.

Add speaker notes.

Check spelling.

Print slides, handouts, notes or outline.

	Activities
	Participant presentations: create an outline of content and add text.

	Readings
	QuickStudy: PowerPoint 2000, p. 4
Quick Source: PowerPoint 2000, pp. 2-3


	Day 3
	Objects and Images

	Objectives
	Describe principles for designing and creating effective electronic presentations.

Draw shapes, lines and text using the drawing toolbar.

Insert, move, resize and group images, clip art, word art and auto shapes.

Create and edit a photo or other image using Windows Paint or a drawing program.
Draw on slides during a presentation.

	Activities
	Participant presentations: format and organise content; add objects and images.

	Readings
	Computers in Your Future 3, Module 4E: Presentation Packages, p. 73
Quick Source: PowerPoint 2000, p. 4


	Day 4
	Charts and Tables

	Objectives
	Describe principles for using an electronic presentation to communicate to a group.

Insert charts, organization charts and tables using AutoLayout or the insert menu.

Change chart data series, type, options and view.

Change organisational chart style, text, background colour, and line and box format.

Change table cell formatting, borders, and text; insert and delete rows and columns.

	Activities
	Participant presentations: add charts and tables, speaker notes; editing and proofing.

	Readings
	Presentation Tips handout
Quick Source: PowerPoint 2000, p. 4


	Day 5
	Multimedia and Data Formats

	Objectives
	List output media options for electronic presentations.

Convert between presentation, word-processed and web page formats.

Create navigational action buttons and hyperlinks to other slides and the web.

Create an automatically running presentation with timings e.g. for a kiosk.

Add and customise slide transition effects and component animations.

Import a Word file, Excel chart, sound clip, movie clip, and animated gif.

	Activities
	Participant presentations (10 minutes each)

Workshop conclusion: save work, check objectives, certificates, evaluation

	Readings
	Computers in Your Future 3, Module 4E: Presentation Packages, pp. 68, 71, review
Quick Source: PowerPoint 2000, p. 5
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